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Vorwort

Der Satz, den ich bei Immunity am haufigsten hore, ist wohl: »Ist es schon fertig?«
Typische Unterhaltungen laufen etwa so ab: »Ich beginne mit der Arbeit an dem
neuen ELF-Importer fur den Immunity Debugger. « Kurze Pause. »Ist er schon fertig? «
oder »Ich habe gerade einen Bug im Internet Explorer gefunden«! Und dann: »Ist der
Exploit schon fertig?« Es ist dieses enorme Tempo bei Entwicklung und Modifikation,
das Python zur perfekten Wahl fir das nichste Sicherheitsprojekt macht, sei es die
Entwicklung eines speziellen Decompilers oder eines vollstindigen Debuggers.

Wenn ich manchmal Ace Hardware hier in South Beach besuche, wird mir ganz
schwindlig, wenn ich den Gang mit den Hammern entlanggehe. Es werden etwa 50
verschiedene Modelle ausgestellt, schon in Reih und Glied sortiert. Jeder weist einen
kleinen, aber extrem wichtigen Unterschied zu den anderen auf. Ich bin nicht Hand-
werker genug, um den idealen Einsatzbereich fur jedes Werkzeug zu erkennen, aber das
gleiche Prinzip gilt auch bei der Entwicklung von Sicherheitstools. Insbesondere bei der
Arbeit an Webanwendungen oder vom Kunden selbst entwickelten Programmen ver-
langt jedes Assessment einen ganz speziellen »Hammer«. In der Lage zu sein, etwas
zusammenzubauen, das sich in die SQL-API einklinkt, hat ein Immunity-Team bei mehr
als einer Gelegenheit gerettet. Aber natiirlich gilt das nicht nur fir Assessments. Sobald
man sich in die SQL-API einklinken kann, ist es einfach, ein Tool zu entwickeln, das
SQL-Queries auf Anomalien untersucht und so Thre Organisation mit einem schnellen
Bugfix vor einem hartnackigen Angreifer schiitzt.

Jeder weifs, dass es sehr schwierig ist, Entwickler von Sicherheitsmafinahmen dazu
zu bewegen, als Teil eines Teams zu arbeiten. Wenn man sie mit irgendeinem Problem
konfrontiert, neigen die meisten von ihnen dazu, zuerst die Bibliothek neu zu schrei-
ben, mit der sie das Problem angehen wollen. Nehmen wir an, es geht um eine Sicher-
heitsliicke in irgendeinem SSL-Daemon. Es ist sehr wahrscheinlich, dass Thr Mitarbei-
ter zuerst einen SSL-Client von Grund auf neu entwickeln will, weil »die vorhandene
SSL-Bibliothek so furchtbar« ist.

Sie miissen das auf jeden Fall verhindern. Die SSL-Bibliothek ist nimlich in Wahr-
heit nicht furchtbar — sie wurde nur nicht in dem Stil geschrieben, den der fragliche
Mitarbeiter bevorzugt. Die Fihigkeit, in einen groflen Codeblock abzutauchen, ein
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Problem zu finden und es zu beheben, ist der Schliissel, um mit einer funktionierenden
SSL-Bibliothek einen Exploit zu entwickeln, der noch relevant ist. Und in der Lage zu
sein, die Mitarbeiter als Team arbeiten zu lassen, ist entscheidend, um die notwendigen
Fortschritte zu erzielen. Ein mit Python vertrauter Entwickler ist viel Wert, ebenso wie
ein Ruby-Spezialist. Der Unterschied ist die Fahigkeit der »Pythonistas« zusammen-
zuarbeiten, alten Quellcode zu nutzen, ohne ihn neu zu schreiben, und dartuber hin-
aus als eine Art Superorganismus zu funktionieren. Die Ameisenkolonie in Threr
Kiiche hat in etwa die gleiche Masse wie ein Tintenfisch, aber es ist wesentlich aufwen-
diger, sie loszuwerden!

Und genau an diesem Punkt hilft Thnen dieses Buch. Sie besitzen wahrscheinlich
schon Tools fir einige der von Thnen zu erledigenden Arbeiten. Sie sagen: »Ich habe
Visual Studio. Es beinhaltet einen Debugger. Ich muss keinen eigenen spezialisierten
Debugger entwickeln.« Oder: »WinDbg besitzt doch eine Plug-in-Schnittstelle? « Und
die Antwort ist natiirlich »Ja«. WinDbg besitzt eine Plug-in-Schnittstelle und Sie kon-
nen diese API nutzen, um sich mit der Zeit etwas Niitzliches aufzubauen. Doch eines
Tages werden Sie sagen: »Mann, es wire doch wesentlich besser, wenn ich das mit
5.000 anderen WinDbg-Nutzern verbinden konnte, damit wir unsere Ergebnisse
abgleichen konnen.« Und wenn Sie Python nutzen, brauchen Sie zusammen gerade
einmal 100 Zeilen Code sowohl fiir einen XML-RPC-Client als auch fiir einen Server,
und schon ist jeder synchronisiert und arbeitet auf der gleichen Wellenldnge.

Hacking ist nicht das Gleiche wie Reverse Engineering — Ihr Ziel besteht nicht
darin, den Originalquellcode der Anwendung ans Licht zu bringen. Thr Ziel ist es, das
Programm oder System besser zu verstehen, als die Leute, die es entwickelt haben.
Sobald Sie dieses Verstindnis besitzen, egal in welcher Form, sind Sie in der Lage, das
Programm anzugreifen und die darin versteckten Exploits an die Oberfliche zu brin-
gen. Das bedeutet, dass Sie zu einem Experten in Sachen Visualisierung, entfernter
Synchronisation, Graphentheorie, der Losung linearer Gleichungen, Techniken der
statischen Analyse und einer ganzen Reihe anderer Dinge werden miissen. Immunitys
Entscheidung in dieser Richtung war die komplette Standardisierung mittels Python,
sodass wir jedes Mal, wenn wir einen Graphenalgorithmus entwickelt haben, diesen
tiber all unsere Tools hinweg nutzen konnten.

In Kapitel 6 zeigt Justin, wie man einen schnellen Hook fiir Firefox entwickelt, der
Benutzernamen und Passworter abfiangt. Das ist einerseits eine Sache, die Malware-
Entwickler machen wiirden — und die Berichte zeigen, dass Malware-Entwickler Hoch-
sprachen fiir genau diese Art von Dingen nutzen (http://philosecurity.org/2009/01/12/
interview-with-an-adware-author). Andererseits ist es etwas, das man in 15 Minuten
zusammenschustern kann, um den Entwicklern diejenigen Annahmen tiber ihre Soft-
ware vorzufiithren, die schlicht und einfach falsch sind. Softwareunternehmen inves-
tieren viel in den Schutz ihrer internen Daten. Angeblich geschieht das aus Sicherheits-
griunden, aber hiufig geht es doch eher um Kopierschutz und Digital Rights Manage-
ment (DRM).
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Einfihrung

Ich habe Python nur wegen des Hackings gelernt — und ich behaupte, dass das auch fiir
eine ganze Reihe anderer Leute gilt. Ich habe viel Zeit damit verbracht, eine Sprache zu
suchen, die sich fiir das Hacking und das Reverse Engineering eignet, und vor ein paar
Jahren wurde mir klar, dass sich Python zum Anfihrer in der Liga der Hacking-Pro-
grammiersprachen entwickeln wiirde. Das Problematische an der Sache war, dass es
keine Anleitung gab, wie man Python fiir eine Vielzahl von Hacking-Aufgaben nutzen
konnte. Man musste sich durch Forum-Postings und Manpages kimpfen und viel Zeit
damit verbringen, den Code immer wieder durchzugehen, damit die Dinge richtig
funktionierten. Dieses Buch mochte diese Liicke schlieffen und Thnen zeigen, wie man
Python auf unterschiedlichste Art und Weise fiir das Hacking und das Reverse Engi-
neering nutzen kann.

Das Buch vermittelt Ihnen die Theorie zu vielen Hacking-Tools und -Techniken,
wie Debuggern, Hintertiiren, Fuzzern, Emulatoren und Code-Injection, und erldutert
ihnen gleichzeitig, wie Sie sich vorgefertigte Python-Tools zunutze machen konnen,
wenn eigene Losungen unnoétig sind. Und Sie lernen nicht nur, wie man Python-
basierte Tools nutzt, sondern wie man solche Tools in Python entwickelt. Doch seien
Sie gewarnt: Dies ist keine allumfassende Referenz! Es gibt sehr viele in Python
geschriebene Infosec-Tools (»Information Security«), die hier nicht behandelt werden.
Dennoch erlaubt es Thnen dieses Buch, Thr Wissen auf viele weitere Anwendungen zu
ubertragen, sodass Sie jedes Python-Tool Threr Wahl nutzen, debuggen, erweitern und
anpassen konnen.

Sie konnen dieses Buch auf verschiedene Arten durcharbeiten. Wenn Sie mit
Python oder der Entwicklung von Hacking-Tools noch nicht vertraut sind, sollten Sie
es vom Anfang bis zum Ende lesen. Sie werden die erforderliche Theorie kennen ler-
nen, Unmengen an Python-Code entwickeln und ein solides Verstindnis dafiir erwer-
ben, wie eine Vielzahl von Hacking- und Reverse-Engineering-Aufgaben anzupacken
sind. Wenn Sie bereits mit Python vertraut sind und die Python-Bibliothek ctypes schon
kennen, dann konnen Sie direkt mit Kapitel 2 loslegen. Diejenigen, die sich schon
linger mit der Materie beschiftigen, konnen sich nach Gutdiinken innerhalb des
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Buches bewegen und Codefragmente oder bestimmte Abschnitte so nutzen, wie es
ihre tigliche Arbeit erfordert.

Ich widme einen GrofSteil der Zeit den Debuggern, angefangen mit der Debugger-
Theorie in Kapitel 2 bis hin zum Immunity Debugger in Kapitel 5. Debugger sind ein
wichtiges Werkzeug fiir jeden Hacker und ich betone ausdricklich, dass ich sie umfas-
send behandle. Danach lernen Sie in den Kapiteln 6 und 7 einige Hooking- und Injec-
tion-Techniken, die einen Teil der Debugging-Konzepte zur Programmkontrolle und
Speicherverarbeitung erweitern.

Der nichste Abschnitt des Buches zeigt, wie man Anwendungen mithilfe soge-
nannter Fuzzer knackt. In Kapitel 8 fithren wir in das Fuzzing ein, und Sie werden
einen eigenen einfachen Datei-Fuzzer entwickeln. In Kapitel 9 nutzen wir das leis-
tungsfahige Sulley Fuzzing-Framework, um einen echten FTP-Daemon zu knacken,
und in Kapitel 10 werden Sie lernen, wie man einen Fuzzer entwickelt, der Windows-
Treiber knackt.

In Kapitel 11 schliefSlich lernen Sie, wie man Aufgaben der statischen Analyse
unter IDA Pro (einem populidren Tool zur bindren statischen Analyse) automatisiert.
Wir runden das Buch in Kapitel 12 mit PyEmu, dem Python-basierten Emulator, ab.

Ich habe versucht, die Codelistings kurz zu halten, wobei ich an bestimmten Stellen
umfangreiche Kommentare eingefiigt habe, die die Funktionsweise des Codes erldu-
tern. Ein Teil des Erlernens einer neuen Sprache oder einer neuen Bibliothek besteht in
der schweiftreibenden Arbeit, den Code tatsachlich »herunterzuschreiben« und die eige-
nen Fehler zu entdecken. Ich empfehle Thnen, den Code wirklich einzugeben, auch wenn
der gesamte Quellcode auf www.dpunkt.de/python-hacking abgelegt ist, damit Sie ihn
bequem herunterladen konnen.

Lassen Sie uns beginnen!



lhre Entwicklungsumgebung
einrichten

Bevor Sie sich der Kunst der Hacking-orientierten Python-Programmierung widmen
konnen, mussen Sie sich zuerst mit dem am wenigsten unterhaltsamen Teil dieses
Buches auseinandersetzen: der Einrichtung Threr Entwicklungsumgebung. Eine solide
Entwicklungsumgebung ist von besonderer Bedeutung, weil sie es Thnen erlaubt, sich
auf die interessanten Informationen in diesem Buch zu konzentrieren, statt Thre Zeit
darauf zu verschwenden, den Code irgendwie zum Laufen zu bringen.

Dieses Kapitel behandelt die Installation von Python 2.5, die Konfiguration Threr
Eclipse-Entwicklungsumgebung und die Grundlagen der Entwicklung C-kompatib-
len Codes mit Python. Sobald Sie Thre Umgebung eingerichtet und die Grundlagen
verstanden haben, liegt Thnen die Welt zu FiifSen. Dieses Buch zeigt Ihnen, was diese
Welt zu bieten hat.

1.1 Anforderungen an das Betriebssystem

Ich setze voraus, dass Sie fir einen Grofteil Threr Entwicklungen eine 32-Bit-Win-
dows-Plattform verwenden. Windows verfugt tiber die grofSte Anzahl von Tools und
eignet sich selbst sehr gut fir die Python-Entwicklung. Alle Kapitel in diesem Buch
sind Windows-spezifisch, und die meisten Beispiele funktionieren nur mit einem Win-
dows-Betriebssystem.

Allerdings gibt es auch einige Beispiele, die Sie unter einer Linux-Distribution aus-
fuhren konnen. Fir die Linux-Entwicklung empfehle ich den Download einer 32-Bit-
Linux-Distribution als VMware-Appliance. VMwares Appliance-Player ist kostenlos
verfiigbar und ermoglicht es Thnen, Dateien von Threm Entwicklungssystem schnell auf
Thre virtuelle Linux-Maschine zu kopieren. Wenn Sie eine Maschine ubrig haben, kon-
nen Sie natiirlich auch eine komplette Distribution darauf installieren. Im Hinblick auf
dieses Buch sollten Sie eine Red Hat-basierte Distribution wie Fedora Core 7 oder
Centos 5 verwenden. Alternativ konnen Sie natiirlich auch mit Linux arbeiten und
Windows emulieren. Es liegt ganz bei Thnen.
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Freie VMware-Images

VMware stellt auf seiner Website ein Verzeichnis mit freien Anwendungen bereit. Diese
ermoglichen es dem Reverse Engineer oder dem Entwickler, der nach Sicherheitsliicken sucht,
Malware oder Anwendungen zu Analysezwecken innerhalb einer virtuellen Maschine auszu-
fihren. Das minimiert das Risiko fir die physikalische Infrastruktur und schafft einen isolier-
ten Bereich, in dem man gefahrlos arbeiten kann. Besuchen Sie den »virtuellen Marktplatz«
unter http://www.vmware.com/appliances/ und laden Sie den Player unter
http://www.vmware.com/ products/player.

1.2 Python 2.5 herunterladen und installieren

Die Python-Installation erfolgt sowohl unter Linux als auch unter Windows schnell
und problemlos. Windows-Anwendern steht ein Installer zur Verfiigung, der sich um
das gesamte Setup kiimmert. Unter Linux erfolgt die Installation hingegen tiber den

Quellcode.

1.2.1  Python unter Windows installieren

Windows-Anwender konnen den Installer von der Python-Homepage herunterladen:
hitp:/lpython.org/ftp/python/2.5.1/python-2.5.1.msi. Klicken Sie den Installer doppelt
an und folgen Sie den einzelnen Installationsschritten. Der Installer legt ein Verzeichnis
namens C:/Python25/ an, in dem der Interpreter python.exe zu finden ist sowie alle
standardmafig installierten Bibliotheken.

Hinweis Alternativ konnen Sie den Immunity Debugger installieren, der nicht nur den
Debugger selbst umfasst, sondern auch einen Installer fiir Python 2.5. In spa-
teren Kapiteln werden wir den Immunity Debugger fiir viele Aufgaben nut-
zen, d.h., Sie konnen gleich zwei Fliegen mit einer Klappe schlagen. Um den
Immunity Debugger herunterzuladen und zu installieren, besuchen Sie
hitp://debugger.immunityinc.com/.

1.2.2  Python unter Linux installieren

Um Python 2.5 unter Linux zu installieren, laden Sie den Quellcode herunter und kom-
pilieren ihn. Dadurch bekommen Sie die vollstandige Kontrolle tiber die Installation,
wihrend Sie gleichzeitig die Python-Installation behalten, die auf einem Red Hat-
basierten System vorhanden ist. Die Installation geht davon aus, dass Sie alle nachfol-
genden Befehle als Benutzer root ausfiihren.

Der erste Schritt besteht im Herunterladen und Entpacken des Python 2.5-Quell-
codes. In einer Terminal-Session geben Sie die folgenden Kommandozeilenbefehle ein:
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# cd /usr/local/

# wget http://python.org/ftp/python/2.5.1/Python-2.5.1.tgz
# tar —zxvf Python-2.5.1.tgz

# mv Python-2.5.1 Python25

# cd Python25

Sie haben nun den Quellcode heruntergeladen und nach /usr/local/Python25 entpackt.
Der nichste Schritt besteht im Kompilieren des Quellcodes und natiirlich miissen Sie
sicherstellen, dass der Python-Interpreter auch funktioniert:

# ./configure --prefix=/usr/local/Python25

# make && make install

# pwd

/usr/local/Python25

# python

Python 2.5.1 (r251:54863, Mar 14 2012, 07:39:18)

[GCC 3.4.6 20060404 (Red Hat 3.4.6-8)] on Linux2

Type "help", "copyright", "credits" or "license" for more information.
>>>

Sie befinden sich nun in der interaktiven Python-Shell, die Thnen den vollstindigen
Zugriff auf den Python-Interpreter und alle verfiigbaren Bibliotheken erlaubt. Ein
schneller Test wird zeigen, ob Befehle korrekt interpretiert werden:

>>> print "Hallo, Welt!"
Hallo, Welt!

>>> exit()

#

Ausgezeichnet! Alles funktioniert so, wie Sie es sich wiinschen. Um sicherzustellen,
dass die Benutzerumgebung automatisch weifs, wo sie den Python-Interpreter findet,
miissen Sie die Datei /root/.bashrc bearbeiten. Ich personlich verwende nano fiir die
gesamte Textbearbeitung, aber Sie konnen natiirlich jeden Thnen vertrauten Editor ver-
wenden. Offnen Sie die Datei /root/.bashrc und fiigen Sie am Ende der Datei die fol-
gende Zeile hinzu:

export PATH=/usr/local/Python25/:$PATH

Diese Zeile teilt der Linux-Umgebung mit, dass der Benutzer root auf den Python-
Interpreter zugreifen kann, ohne den vollstindigen Pfad verwenden zu mussen. Nach-
dem Sie sich als root aus- und wieder eingeloggt haben, konnen Sie in der Kommando-
zeile jederzeit python eingeben und landen direkt im Python-Interpreter.

Nachdem Sie nun einen voll funktionsfahigen Python-Interpreter sowohl fiir Win-
dows als auch fur Linux besitzen, wird es Zeit, Thre integrierte Entwicklungsumgebung
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(Integrated Development Environment, kurz IDE) einzurichten. Wenn Sie bereits eine
eigene IDE verwenden, konnen Sie den folgenden Abschnitt iiberspringen.

1.3 Einrichten von Eclipse und PyDev

Um Python-Anwendungen schnell entwickeln und debuggen zu konnen, ist der Einsatz
einer guten IDE unverzichtbar. Die Verbindung der popularen Eclipse-Entwicklungs-
umgebung mit einem Modul namens PyDev stellt Thnen eine Vielzahl leistungsfahi-
ger Features zur Verfligung, die die meisten anderen IDEs nicht zu bieten haben.
Eclipse lauft unter Windows, Linux und Mac und der Support durch die Community ist
ausgezeichnet. Sehen wir uns im Folgenden an, wie man Eclipse und PyDev installiert
und konfiguriert:

1. Laden sie das Paket Eclipse Classic von htip://www.eclipse.org/downloads/ her-
unter.

2. Entpacken Sie es nach C:\Eclipse.

3. Fiihren Sie C:\Eclipse\eclipse.exe aus.

4. Beim ersten Start werden Sie gefragt, wo Thr Workspace gespeichert werden soll.
Akzeptieren Sie die Voreinstellung und aktivieren Sie die Checkbox Use this as
default and do not ask again, um nicht wieder nach dem Workspace gefragt zu
werden. Klicken Sie dann auf OK.

5. Sobald Eclipse gestartet wurde, wihlen Sie Help » Software Updates » Find and
Install.

6. Aktivieren Sie den Radiobutton namens Search for new features to install und kli-
cken Sie auf Next.

7. Auf der nichsten Seite klicken Sie auf New Remote Site.

8. Geben Sie nun im Feld Name einen beschreibenden Text wie PyDev Update ein.
Stellen Sie sicher, dass das URL-Feld den Link htep://pydev.sourceforge.net/up-
dates/ enthilt und klicken Sie auf OK. SchliefSen Sie den Vorgang mit einem Klick
auf Finish ab, um den Eclipse-Updater zu starten.

9. Nach kurzer Zeit erscheint der Update-Dialog. Klappen Sie den Punkt PyDev Up-
date auf und aktivieren Sie das PyDev-Element. Klicken Sie auf Next.

10. Lesen Sie sich nun die Lizenzvereinbarung fur PyDev durch. Wenn Sie mit den Be-
dingungen einverstanden sind, klicken Sie den Radiobutton I accept the terms in
the license agreement an.

11. Klicken Sie nun Next und dann Finish an. Eclipse beginnt nun damit, die PyDev-
Erweiterung herunterzuladen. Nachdem das geschehen ist, klicken Sie auf Install
All

12. Der letzte Schritt besteht darin, den Yes-Button in der Dialogbox anzuklicken, die
nach der Installation von PyDev erscheint. Nach dem Neustart von Eclipse steht
Thnen PyDev zur Verfiigung.
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Der nichste Schritt bei der Eclipse-Konfiguration besteht darin sicherzustellen, dass
PyDev den richtigen Python-Interpreter findet, wenn Sie Skripten innerhalb von PyDev
ausfithren wollen:

In Eclipse wihlen Sie Window » Preferences.

Klappen Sie den PyDev-Baum auf und wihlen Sie Interpreter — Python.

Im Abschnitt Python-Interpreter zu Beginn des Dialogs klicken Sie auf New.
Wahlen Sie C:\Python25\python.exe aus und klicken Sie auf Open.

Der nichste Dialog zeigt eine Liste der verfiigbaren Bibliotheken fiir den Interpre-
ter. Behalten Sie alle Einstellungen bei und klicken Sie einfach auf OK.

6. Klicken Sie noch einmal auf OK, um das Interpreter-Setup abzuschliefSen.

ke

Sie besitzen nun eine funktionierende PyDev-Installation, die fir den Einsatz IThres
frisch installierten Python 2.5-Interpreters eingerichtet ist. Bevor Sie mit dem Pro-
grammieren beginnen kénnen, miissen Sie ein neues PyDev-Projekt anlegen. Dieses
Projekt wird alle Quelldateien enthalten, die wir im Verlauf dieses Buches verwenden.
Um ein neues Projekt einzurichten, sind folgende Schritte notwendig:

1. Waihlen Sie File » New » Project.

2. Klappen Sie den PyDev-Baum auf, wahlen Sie PyDev Project und klicken Sie dann
auf Next.

3. Nennen Sie das Projekt Gray Hat Python und klicken Sie auf Finish.

Sie werden bemerken, dass sich Thr Eclipse-Layout selbst neu anordnet, und Sie
sollten das Gray Hat Python-Projekt oben links auf dem Bildschirm sehen. Klicken
Sie den Ordner src mit der rechten Maustaste an und wiahlen Sie New » PyDev
Module. Im Feld Name geben Sie chapter1-test ein und klicken auf Finish. Sie werden
bemerken, dass die Projektleiste aktualisiert und die Datei chapterl-test.py in die Liste
eingefugt wurde.

Um Python-Skripten unter Eclipse auszufiihren, klicken Sie einfach den Run As-
Button (den grunen Kreis mit dem weiflen Pfeil) in der Werkzeugleiste an. Um das
zuletzt von Thnen ausgefithrte Skript erneut auszufithren, driicken Sie CTRL-F11.
Wenn Sie ein Skript innerhalb von Eclipse ausfiihren, erscheint die Ausgabe nicht in
einem Kommandozeilenfenster, sondern in einem Bereich namens Console am unteren
Rand des Eclipse-Bildschirms. Alle Ausgaben Thres Skripts erscheinen in diesem Con-
sole-Bereich. Sie werden bemerken, dass der Editor die Datei chapterl-test.py geoffnet
hat und auf etwas siiffen Python-Nektar wartet.

1.3.1  Des Hackers bester Freund: ctypes

Das Python-Modul ctypes ist die mit Abstand machtigste Bibliothek, die dem Python-
Entwickler zur Verfugung steht. Die ctypes-Library ermoglicht es Thnen, Funktionen in
DLLs (Dynamic Link Libraries) aufzurufen, und besitzt weitreichende Moglichkeiten
zum Aufbau komplexer C-Datentypen sowie Hilfsfunktionen zur Manipulation des
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(Arbeits-)Speichers auf niedriger Ebene. Es ist wichtig, dass Sie die Grundlagen der
Verwendung der ctypes-Library verstehen, da Sie diese im Verlauf des gesamten
Buches hiufig nutzen werden.

1.3.2 Dynamische Libraries nutzen

Um sich ctypes zunutze machen zu koénnen, missen Sie zunichst verstehen, wie man
Funktionen in DLLs auflost und auf sie zugreift. Eine DLL ist ein kompiliertes Binary,
das zur Laufzeit des Hauptprozesses dynamisch eingebunden wird. Unter Windows
heifSen diese Binaries Dynamic Link Libraries (DLL), unter Linux werden sie Shared
Objects (SO) genannt. In beiden Fillen stellen diese Binaries Funktionen iiber expor-
tierte Namen zur Verfligung, die im Speicher in reale Adressen aufgelost werden. Nor-
malerweise miissen Sie zur Laufzeit diese Funktionsadressen auflésen, um die Funktio-
nen aufrufen zu konnen. Mit ctypes ist die Schmutzarbeit aber bereits erledigt.

Es gibt drei verschiedene Wege, dynamische Libraries mit ctypes zu laden: c¢d11(),
wind11() und oled11(). Die Unterschiede zwischen diesen Dreien liegen in der Art und
Weise, wie die Funktionen innerhalb der Libraries aufgerufen werden, und in den
resultierenden Riickgabewerten. Die Methode cd11() wird fiir das Laden von Libra-
ries verwendet, die Funktionen nach der Standardaufrufkonvention cdecl exportieren.
Die Methode wind11() 1ddt Bibliotheken, die nach der Aufrufkonvention stdcall (einer
nativen Konvention der Microsoft Win32-API) exportieren. Die Methode oled11()
funktioniert genau wie die wind11()-Methode, erwartet aber, dass die exportierten
Funktionen einen Windows HRESULT-Fehlercode zuriickgeben, der speziell fiir Feh-
lermeldungen verwendet wird, die von Funktionen des Microsoft Component Object
Model (COM) zurickgegeben werden.

Als kurzes Beispiel wollen wir die printf()-Funktion der C-Runtime sowohl
unter Windows als auch unter Linux auflosen und diese verwenden, um eine Test-
nachricht auszugeben. Bei Windows heifst die C-Runtime msvcrt.dll und ist unter
CAWIND O WS\system32\ zu finden. Bei Linux heifit sie libc.so.6 und liegt standard-
mifig in /lib/. Legen Sie (entweder in Eclipse oder in Threm normalen Python-
Arbeitsverzeichnis) ein Skript namens chapter1-printf.py an und geben Sie den folgen-
den Code ein.

chapter1-printf.py-Code fiir Windows

from ctypes import *

msvert = cd11.msvert
message_string = "Hallo, Welt!\n"
msvert.printf("Test:: %s", message_string)
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Hier die Ausgabe dieses Skripts:

C:\Python25> python chapterl-printf.py
Test: Hallo, Welt!
C:\Python25>

Unter Linux sieht dieses Beispiel etwas anders aus, fithrt aber zum gleichen Ergebnis.
Wechseln Sie zu Threr Linux-Installation und legen Sie die Datei chapterl-printf.py in
Threm /root/-Verzeichnis an.

chapter1-printf.py-Code fiir Linux

from ctypes import *

libc = CDLL("Tibc.s0.6")
message_string = "Hallo, Welt!\n"
libc.printf("Test: %s", message_string)

Hier die Ausgabe der Linux-Version Thres Skripts:

# python /root/chapterl-printf.py
Test: Hallo, Welt!
#

Sie sehen, wie einfach die Einbindung einer dynamischen Library und die Verwendung
einer von ihr exportierten Funktion ist. Sie werden diese Technik in diesem Buch sehr
hiufig verwenden, weshalb es wichtig ist, die Funktionsweise zu verstehen.

Aufrufkonventionen

Eine Aufrufkonvention beschreibt, wie eine bestimmte Funktion korrekt aufzurufen ist. Das
umfasst die Reihenfolge der Allozierung der Funktionsparameter, welche Parameter auf dem
Stack abgelegt oder in Registern Ubergeben werden und wie der Stack geleert wird, wenn die
Funktion zuriickkehrt. Sie miissen zwei Aufrufkonventionen verstehen: cdecl und stdcall. Bei
der cdecl-Konvention werden Parameter von rechts nach links auf den Stack geschoben und
die Funktion ist dafiir verantwortlich, dass die Argumente vom Stack entfernt werden. Sie
wird von den meisten C-Systemen fiir die x86-Architektur verwendet.
Hier ein Beispiel fir einen cdecl-Funktionsaufruf:

InC

int python_rocks(reason_one, reason_two, reason_three);
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In x86-Assembler

push reason_three
push reason_two
push reason_one
call python_rocks
add esp, 12

Sie kénnen deutlich erkennen, wie die Argumente Ubergeben werden und dass die letzte
Zeile den Stackpointer um 12 Bytes inkrementiert (die Funktion besitzt 3 Parameter und jeder
Stackparameter ist 4 Byte grof3, daher 12 Byte), wodurch die Parameter vom Stack entfernt
werden.

Ein Beispiel fiir die stdcall-Konvention, die von der Win32-API verwendet wird, sehen Sie hier:

InC

int my_socks(color_one, color_two, color_three);

In x86-Assembler

push color_three
push color_two
push color_one
call my socks

Wie Sie sehen, ist die Reihenfolge der Parameter identisch, aber das Aufraumen des Stacks
erfolgt nicht durch den Aufrufer. Vielmehr muss das die Funktion my_socks erledigen, bevor
sie zurtickkehrt.

Fir beide Konventionen gilt als wichtiger Winweis, dass die Rickgabewerte im EAX-Regi-
ster gespeichert werden.

1.3.3  C-Datentypen konstruieren

Auch die Moglichkeit, einen C-Datentypen mit Python zu erzeugen, ist auf eine
schriage Art recht sexy. Dank dieses Features konnen Sie in C und C++ geschriebene
Komponenten vollstandig integrieren, was die Leistungsfihigkeit von Python deutlich
erhoht. Die Tabelle 1-1 zeigt, wie die Datentypen zwischen C, Python und dem resultie-
renden ctypes-Typ abgebildet werden.
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C-Typ Python-Typ ctypes-Typ
char 1-character string c_char
wchar_t 1-character Unicode string c_wchar
char int/long c_byte

char int/long c_ubyte
short int/long c_short
unsigned short int/long c_ushort

int int/long C_int
unsigned int int/long c_uint

long int/long c_long
unsigned long int/long c_ulong
long long int/long c_longlong
unsigned long long int/long c_ulonglong
float float c_float
double float c_double
char * (NULL terminated) string or none c_char_p
wchar_t * (NULL terminated) unicode or none c_wchar_p
void * int/long or none c_void_p

Tab. 1-1 Abbildung von Python- in C-Datentypen

Sehen Sie, wie schon die Datentypen untereinander konvertiert werden konnen? Halten
Sie diese Tabelle griffbereit, fiir den Fall, dass Sie dieses Mapping vergessen. Die ctypes-
Typen konnen mit einem Wert initialisiert werden, dieser muss aber vom richtigten
Typ und der richtigen Grofe sein. Um das zu demonstrieren, 6ffnen Sie die Python-
Shell und geben Sie die folgenden Beispiele ein:

C:\Python25> python.exe

Python 2.5 (r25:51908, Sep 19 2006, 09:52:17) [MSC v.1310 32 bit (Intel)] on win32

Type "help", "copyright", "credits" or "license" for more information.

>>> from ctypes import *
>>> c_int()

c_long(0)

>>> ¢_char_p("Hallo, Welt!")
c_char_p('Hallo, Welt!")

>>> ¢_ushort(-5)

c_ushort (65531)

>>>

>>> seitz = c_char_p("loves the python")

>>> print seitz
c_char_p('loves the python')
>>> print seitz.value

loves the python

>>> exit()




